DRUAGHNDRI SRR

RISC OSPi and all RISC OS 5 machines

SDFS::HardDisc0.8.Graphics einstein Lock

pt®%%» | Einstein Tile

Al o
2|00z RI2IX

3D Turbo Boost
Draw to JPEGs

Custom lcon Bars
Raspberry Pi GPIO




http://mug.riscos.org/mega

MUG Mega
Meet 23

A virtual 3%

Global User
Meeting

MUG Mega Meet 2023
saturday 1st July 11.00 - 4.00

Saturday 1st July 11.00 - 4.00

&
=
=
(¥ 19
~
-
(»
=
Q)
7]
&
et
(=W
-
(7]
()
B
)
=
=
™)
(S
V]
(o
2
[~



Copyright ©2023 Drag ‘N Drop. All rights reserved.
Produced on RISC OS computers

This issue has been blessed with contributions from
the following people:

Anthony Bartram (Anatomy of a Game)
Brian K Charradia (Risc OZ)
Christopher Dewhurst (everything else)
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necessarily those of the editor. Alternative views are
always welcome and can be expressed by either
writing an article or a short editorial.
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Editorial
Hi RISC OS users and welcome to another edition of Drag ’N Drop! 1 know that a
number of you like to print your magazine so I hope you like the new, wider
format which prints in landscape orientation on A5 (or enlarged to A4 landscape).
Drag ’N Drop isn't able to be at the Wakefield (Bradford) show this year but if you
are going then have a good time — and even if you aren't, enjoy reading this
edition of the magazine.
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Beginners

Entering listings
You can type in programs in three
ways:

1. Use a text editor like

Edit. Press the Menu Tcr&ma
. ext

mouse button over Edit BASIC
on the icon bar and
choose Create>BASIC. | ©Pe¥
For other languages type | “emmand
in at the bottom. Save it |_Python]
by pressing F3.

2. Press F12 and type
BASIC and press return.
Change the screen mode
with MODE n where n is a

number e.g. MODE 7.

Type AUTO for automatic line
numbering. Press Escape to stop and
type SAVE "myprog" followed by
Return to store myprog on hard disc.
Type RUN to execute the program. To
return to the desktop type *QUIT.
Programs listed
in Drag’N
Drop are
assumed to
work on all
machines with

Menu Adjust

Select

Scroll wheel mouse

RISC OS 5 e.g. Raspberry Pi, unless
otherwise stated.

3. You can also type programs in a
task window, Menu over the Raspberry
icon on the right side of the icon bar
and choose Tasl window, or press
Ctrl+F12. You won't be able to change
screen mode or use the cursor keys,
though. However, GraphTask from
armclub.org.uk/free/ allows you to type
in and run Basic programs that use
simple graphics (not sprites) in a
window on the desktop.

[ Taskwindow [=[5] Graphic Task Window
“BASIC =
ARM BBC BASIC V
version 1.54
Starting with 651516
bytes free
>
=N
4 D2

Program lines aren’t numbered. Each
line starts with space so you know
when to press Return. To find out the
line number you are on press f5 in Edit.

ROCHRICONF (M1,6,18¢<28,15¢{28): PROCHR
ICOMI(HL, 6, "Process")

Start of line has a space
Continuation of line (no space)

To run Basic programs from the
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desktop, double-clicking with
select on the filer icon runs it.
Holding down Shift and double
clicking loads it back into !Edit.

More memory for applications
You may need to reserve more memory
for a program. Adjust-click on the
Raspberry icon and under Application
tasks click and drag the Next slide bar
out to the right.

Next 1440K I

What does ‘currently selected
directory’ mean?

Articles may tell you to set the CSD
(currently selected directory). Click
menu over filer window and choose Set
directory "W. It’s where the computer
stores the file when you type SAVE

“myprog”.

How do | open an Applcation
Directory?

Application directories begin with a !
called 'pling', for example 'pling boot'.
To open (without running) it, hold



down the shift key and double click
select to open the directory.

== Blank screen when

[ {.‘}] running games listings
IE-out Check you have the Anymode

module installed, download it
from www.pi-star.co.uk/anymode. It
goes in |Boot.Choices.Boot. Predesk.
Open the !Boot application directory,

in the root directory of the SD Card,

that is SDFS::RISCOSPi. $.!Boot.

Locate the Loader file and

with Shift held down double click it to

open it. Create a text file in Edit with

the following line (press Return at the

end):

disable_node_changes

Save it inside Loader as CMDLINE/

TXT and restart your machine.

‘Screen mode not available’
Check you have Anymode (see above).
The other issue may be Aemulor which
can interfere with screen modes. Menu
over iconbar > Quit > Emulator too.

Sounds are strange

Some listings need the free RDSP
module installed. Download it from
www.amcog-games.co.uk/rdsp.htm
where you’ll find instructions on how
to install it.

WIMP library

Many programs in Drag 'N Drop are
multi-tasking (running in a window on
the desktop). They use a set of standard
procedures to create and deal with
windows, icons and menus.

Rather than publish them with every
listing they are collected here. Most of
them are taken from The Application
Tutorial and Listings Book available
from Drag "N Drop Publications. If
you're interested in writing desktop
applications then you should consider
buying this book.

DEF FHMKHINDOW

READ T,X,Y,H.H

FOR I=8 TO 84 STEP 4
READ A%

I!B=EVALA%

HEXT

T+= LEN $T+1

S;S "Wimp_CreateHindow",,B TO ¥

Basic’s DATA pointer is assumed to be
at a line giving window title, position,
size, colours, flags comes before this is
called. Memory blocks T and B must
have been set up. Makes a window
returning handle in X.

DEF PROCHKICONCH,Z,Y,H,D,F,A%,1)
$U=A% : RESTORE +1

DATA H,%,Y,%4H,Y4D,F, U,U,LEN A%+l
FOR I=8 TD 32 STEP 4

READ B% : I'B = EVAL B%

NEXT : Ut= LEN A%+l

5YS "Wimp_CreateIcon",,B T0 I
ENDPROC

Make an icon, handle is returned in 1.
H=window handle, X,Y=bottom left,
W.,D=dimensions, F=flags, A$=text and
V validation string (1 if none)

DEF PROCRDICOHCH,H)

IB=H : Bl4=H

5Y5 "Himp_GetIconState",,B
As=$(B128) : X = BI24

EHDPROC
Read icon W in window H text in A$

and flags in X.
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DEF PROCHRICONT(H,H,B%)
PROCRDICONCH, H)

B!8=8 : B!12=8

$(B128)=B%

5Y5 "Wimp_SetIconState",,B

EHDPROC

Updates text BS in icon H in window
W.

DEF PROCWRICOHFCW,H,%,Y)

IB=W : B!4=H : B!8=R : BI12=Y

5Y5 "Wimp_SetIconState",,B

EHDPROC
Updates icon W’s flag in Window H, X
1s the EOR word and Y the clear word,
ie flag = (flag AND NOT X) EOR Y.

DEF PROCMKMENUCR)

READ T

FOR I=8 T0 24 STEP 4

READ A% : I!A=EVAL A%

NEXT : T+= LEN $T+l

ENDPROC

DATA line before this is called with
menu header details. Sets up menu
header at memory address A.

DEF PROCMKENTRY(M,X,Y,H,F,A%,0)
$l=R%

RESTORE+1

DATA Y,H,F,U,V,LEN U
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FOR I=8 TO 28 STEP 4

READ B

TI(H+R) = EVAL B%

HERT : U+= LEN $U + 1

ENDPROC
Basic DATA line before this is called
giving menu item details. W=header
address, X=offset (multiple of 24),
Y=work flags, H=submenu pointer (-1
if none). F, A$ and V as for
PROCMKICON. Add entry for menu
already set up.

DEF PROCMKSPRITE

READ A%, M,H,M,PU,NC

HS::IS "05_SpriteDp", &10F,5,A%,-(NCOXD) W,
5YS "05_Spritelp",%125,5,R%,-1 70 ,,,,C
H%;THE FOR X=8 TO HC#8 STEP 8:READ C!X:
READ J$: J=EUAL("§"+]%): K=PH

FOR Y=H-1 T0 @ STEP -1: FOR X=@ T0 W-1
S¥§ "0S_Spritelp",%128,5,R%,%,Y,]
J=132(32 DIV P : K-=1 @ IF K=@ K=PW: R
EAD J%: J=EVAL("%"+]%)

HEXT: HEXT

ENDPROC

Create a sprite. DATA pointer must be
be at a line giving sprite's name, width,
height, mode, pixels per word (eg 32

Spring 2023

for 2-colour) and number of colours
before PROCMKSPRITE called. If
number of colours >0 the following
words give RGB palette entries. Shape
DATA then given as words (without &)
in compacted format. Intended for use
with 2-, 4- and 16-colour sprites.

DEF FHPROGIHFO

RESTORE +1

DATA About this program,®,8,580,208,%,Y
AW, Y+H,8,8,-1,884081012, 81008287, 8C018
3,8,-H,M,8,8130,8,1,8,7,0,8,8

HX=FNHKWINDOW: $U="R2"

DATA Name,Purpose,Author,Version

DATA Application Demo,Drag N Drop,n.m ¢
dd-nn-yyyy)

FOR IC=8 TO 7

READ A%:LOCAL DATA

IF IC{4 PROCHKICOH(X,8,-38-IC#58,138,38
,97080381,R%,8)

IF IC>3 PROCHKICOH(X,148,-508-(IC HOD4)#
38,358,58, 97888180, A%, V)

RESTORE DATA

HEXT

=}¥
Create and return handle of ‘About this
program’ window. Adust 3rd line of
data as needed. Needs
FNMKWINDOW and FNMKICON.



News and Apps

RISC OS Yorkshire

By the time you read this the RISC OS
show oop north will be in full swing.
Organised by the Wakefield RISC OS
Computer Club (WROCC) it’s taking
place in the Cedar Court Hotel
Bradford 10.30am—-4.30pm on 22nd
April. Prices a whole £2.00 on the door.

WROCC design competition
The user group is looking to update
their logo and submissions are invited
with a closing date of 22nd April
(presumably the winner will be
announced at the show then). Find out
more at www.wrocc.org.uk.

Spark of an idea

SparkFS has been bundled as read-
onlywith RISC OS distros, usually the
default app for opening Zip files from
the Internet. If you wanted to create
your own compressed files you had to
buy the full version but now that is
being bundled free with the HardDisc4

image too. SparkFS can
handle a variety of
compressed formats.

RISCWord

Development of a RISC OS
version of Microsoft Word
has begun by retired physics
Prof Ali Lo who is looking
for beta testers, visit
tinyurl.com/3sn2rd9u to

RAM::RamDisc0.$.MSDoc

Draw »
Text N
MSWord »

1 RTF 4

D |

learn more.
.
CLFiler 1.02
CE3] SOFS HardOised § Uitios. ==
Jsorsharoec 0 21 O[T Ol 2l | ] o ([Name 0 L coor T30 A
& 5 i B ==
IBASIC Rlp  [CDFaker  IChangeFSI Claans FEer Parthigr
#* B (#)
ich ‘FIMI\SM’ 15c0rmbbee  IShowScrap  Snapper 1SparkFS
M s 4 WO
SirongED  1StengHlp 1T ToFort mFz WnTarBZ2 ‘I.N-noe
2 P B

Lsies .08 Dir {21 itrs) | 11:35:38 19-001- 2020 | £

The drag and drop nature of the RISC
OS filing system and integration with

i1k

Lies

applications is reknowned for its ease
of use but this hasn't stopped Stefan
Froling developing an even better
version of it. CLFiler is available on a
‘pre-order’ scheme where for a one-off
payment of €15.97 you get monthly
beta updates. See riscoscloverleaf.com/
product/new-filer-gui-pre-order. to find
out more.

CloudFS 0.34

Cloud storage is the practice of keeping
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files on the internet (a data centre
or server) instead of on your (
Raspberry Pi (local machine).

The internet keeps backups on
different servers so you don’t
need to worry about losing your

work and you can access your

files anywhere you have an

internet connection. Elesar’s CloudFS
allows you to interact with the cloud
just like the normal RISC OS filing
system with a standard filer window.
Version 0.34 has had some tweaks and
is free to existing users or £28.80 for
new users. Visit shop.elesar.co.uk >
Software.

MkSprite 1.11
MkSprite 1s a pacakge of two
command-line driven utilities to

for not going. For more details

I ' visit
mgect!;l;zga s T Biitineia W mug.riscos.org/mega/
A virtual 1st July 2023 Zoom Virtual.html.
glmbt@l User Entirely
i Fie | Next Issue
A And speaking of summer, the

convert Drawfiles and Euclid
files; it also merges sprites.
Example files are included but
not instructions — copy the contents of
MkSprite-1/11/zip.Library to your
'Boot.Library, double click
Examples.test and the result is
Examples.draw_s which you can open
in Paint.

Midlands Mega Meet

The RISC OS Midlands user group,
traditionally known as the MUG, is
holding a global meeting on 1st July
2023 and you don’t even have to get
out of bed to attend! As long as you
have a device other than your RISC OS
machine you can join on Zoom (for
sadly there’s no version of Zoom for
RISC OS just yet). So there's no excuse
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L mug.riscos.org

next issue of Drag "N Drop will
be out at the beginning of August. Due
to space in this issue of the magazine,
Using Sound and Colour Properly will
be back plus a couple of high quality
and very useful type-in applications
along with all the regulars. See you!




Be fast or be last

Supplier: Amcog Games

ww.amcog-games.co.uk
Price £11.99 (Plingsotre)
RISC OS gameswriter Tony Bartram
of Amcog has turned his hand to a 3D
car racing game.
You’ve been selected to test drive a
range of indestructible cars (so the story

goes) and you race them against the
‘.""7“""

computer or another player.

The introductory screen lets you
modify control keys, choose from five
soundtracks, composed by Mr Bartram
himself, and which one of four vehicles
to drive. Think of beefy stunt cars from
70s and 80s TV series like Knight Rider
and you get the idea.

The race begins on a screen with a
3D split view — from the other car's

Iiflilii

&iiiflﬁi

perspective at the top and yours at the
bottom. There is some nice background
scenery (mountains on the first level)
although it doesn’t move as you steer
left and right to negotiate bends and
obstacles blocking the road. Crash into
a massive concrete bollard and you
don't even sustain a scratch, just rev
your engines back up and get on your
way.

Once you hit an open stretch and get
speed up you can apply one of the
eponymous turbo boosts. You can slow
down and steer round the blockage or
leap over them using up one of four
jumps. This makes six control keys —
left, right, speed up, slow down, jump
and apply turbo charger.

The car’s speedometer and number
of remaining boosts and jumps are
clearly drawn on the right.

[ liked the fact that when you catch
up with the other car (or vice versa) it
appears in your portion of the screen.
@ Being an immortal driver in an
indestructible car is great fun. When
both cars try to occupy the same space
on the road the ensuing kerfuffle is
quite entertaining.

Spring 2023 www.dragdrop.co.uk Drag 'N Drop 9



Einstein Tiles

You may have read in the press
recently about the discovery of a 13-
sided ‘Einstein tile’ by retired
Yorkshire printing engineer, David
Smith.

Einstein has nothing to do with he of
General Relativity — in German
‘einstein’ means ’one stone’ and
mathematicians have been looking for
such a ‘stone’ or tile for years. It can be
used to cover a surface without creating
a repeated pattern.

The technical name for this shape an
‘aperiodic monotile’. An einstein tile is
just a hexagon cut up and rearranged
into another shape which is rotated in
steps of 60 degrees and flipped to make
12 shapes to tesellate on the 2D plane.

In this article we will use Draw,
which has come free with every version
of RISC OS, to create the einstein tile,
the 12 variations, and placing them to
create a fascinating pattern. Be warned,
it’s addictive!

First of all load up Draw by select
clicking on the Apps folder and double

pattern as shown below.

PN

clicking !Draw. Select click the icon bar | . _ ‘ ‘ .

to open a new Draw document. We : :

need an isometric grid so click the | ‘ + ‘ :
Menu mouse button > Grid. Using the /\\ '
Adjust button click on Show, Lock and \\/ \

Isometric. Leave the spacing as the
default which is 1cm with 2 divisions
(meaning objects snap to the nearest 1/2
cm or Smm).

Now select the closed straight line
tool (the one that looks like a wonky
bow tie). Draw a hexagon, using the
spots on the isometric grid to help

K /L

Select the close-line tool again.
Construct the 13-sided tile with the
control p01nts shown below.

P )a
Al
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Now create three copies of the hexagon.
Ensure it is selected (select click
anywhere on it) and choose Menu >
Select > Duplicate) or Ctrl+D. Arrange
the four hexagons in honeycomb



Anatomy of a Game -

5. A car duel, where only 2 cars are
The latest title from AMCOG is a 3D At the core of the game there should competing.

car racing game. It’s our first two be some key distinctive focus that For (1) I felt that one player could gain

player title and also includes the defines what the game is about and an advantage and then progressively

option of playing against the makes it fun. I went through multiple disadvantage the other player.

computer. designs: This would seem to prevent an
There were a number of challenges 1. Collecting and using powerups e.g.  effective competition. So I decided that

in producing a game like this and this nitrous oxide for speed, oil or smoke any power-ups would be non-

article explores the kind of problems to thwart an adversary. collectable and fairly distributed.

that were encountered and how these 2. Running away from the law. I selected (4) as a design and thought

were solved. It also takes a look at how
the graphics, sounds and music were
made.

Game Design

Game design is perhaps the hardest part
of developing a game. The game needs
to be fun, so there should be some
known entertaining aspect to the game
e.g. being chased, solving puzzles,
having a time limit, competing against
an adversary, answering questions etc.
This is with a view to triggering either
the flight or flight response, a sense of
nostalgia, endorphins, or entertain in
some other way.
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Draw to Jpegs

I wrote this application to convert a
directory of drawfiles to Jpeg format
for putting in HTML documents.

Users of non-RISC OS platforms can
then view RISC OS drawfiles as part of
a web page — rather than printing a
Drawfile to PostScript/PDF and making
the web browser download the file each
time.

Draw2Jpgs, the application listed
here, can be used in conjunction with
DDF2Html (discussed later) to convert
Impression Style files to HTML. It
needs ChangeFSI to work behind the
scenes, this is supplied in the ROOL
distros of RISC OS so most users will
have it already installed.

In Style, if choose File > Preferences
and uncheck Single file document,
Style will save the document as an
application directory.

If you downloaded Style 2019 from
Pingstore there are a couple of files
saved in this format, ! Tutorial for
instance. Inside !Tutorial (hold down
shift and double click the ‘I” application

icon). There are subfolders called
Chapter 1, Chapter 12 etc. Inside them
are drawfiles called Story11, Story 13
and so on. These are numbered in order
of creation rather than appearance, for
example the Chapter 26 folder actually
is the first chapter in the document.
Before you do anything else, adjust
the memory allocated to applications by
adjust-clicking the switcher (raspberry)
icon and drag the red Next bar in the
top section. Drag it out to at least a
couple of megabytes (2048K). If you
don’t the application will report an

Application

the blank rectangle to the right of ‘Input
dir’ field. Create a suitable directory (eg
Images) and drag that into the ‘Output
dir’. Adjust the scale if desired. Click
the large green Process button to begin.

HES| RAM::RamDisc0.$.Images X
s {Chapter1_Story 10/jpgRIIEY 4k JPEG L
%5 Chapteri_Story11/jpg WR/ 4k JPEG
sz Chapter1_Story12/jpg WR/ 4k JPEG
2 Chapter1_Story13/jpg WR/ 4k JPEG
2 Chapter1_Story14/jpg WR/ 4k JPEG
%5 Chapter1_Story15/pg WR/ 4k JPEG
%3 Chapter1_Story16/jpg WR/ 4k JPEG
%5 Chapter1_Story19/pg WR/ 11k JPEG
& Chapter1_StoryS/jpg WR/ 26k JPEG
s Chapteri_Story8jpg  WR/ 4k JPEG v
s Chapteri_Story9jpg WR/ 4k JPEG [}

Notice the button turns red, you are

- processing large

error message and refuse to run.

Then type in the listing and save it as
DRAW2JPGS. Double check you haven’t
made a typing slip and run it. All being
well a window should appear like the
above. Drag a chapter directory onto

Ui e Draw2J R
|| I di RAM::RamDisc0.$./D PG;J Chapter1 Scale %100 l numbes of drawings
nputdir | RamDisc0.$.'Demodoc. Chapter e %[ 100] and want to stop for
Output dir | RAM::RamDisc0.$.Images - any reason, hold down
[Ready the Menu button to halt
conversion.

The Images directory will contain
Jpegs with filenames beginning with
the Chapter directory name and Story
name separated by an underscore.

The above example is from the
Demodoc in the Documents folder.
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Custom Icon Bars

Last time we created out own set of
Toolsprites and we'll round off by
sprucing up the usual boring, grey
icon bar.

The iconbar is actually a window
with no furniture. Making our own
iconbar window is done in four stages:
1. Add an iconbar-sized sprite icon to

the iconbar window definition that is

held inside the Wimp templates file
2. Design or obtain a sprite for the
sprite icon
3. Write a relocatable module to
instruct RISC OS to ‘soft load’ the
new templates into the Resource

Filing System
4. Add a small Obey file to your Boot

sequence to activate the softload on

bootup.

This all sounds intensely scary but
don’t panic, I'll walk you through it.

The computer has a default set of

%’%@

0 HostFS Discs 0 Apps RAM

window templates including one for the
iconbar. These are located in the
Resources folder — menu click over
Apps on the iconbar > Open ‘$’.
Navigate to Resources.Wimp and that’s
where the file Templates live.

You’ 1l need the WinEd utility, go to
www.riscosopen.org > Downloads >
Miscellaneous >Bonus binaries. It’s
located in in the BonusBinDev/zip
download in HardDisc4.Utilities.
Developer.

Double click the Templates file. In
the pictorial list of windows double
click iconbar and the grey iconbar
rectangle will appear.

Adjust-click on WinEd’s iconbar
icon to bring up the icon palette. Drag
the Label icon from the palette to the
window. Double click it. In the Label
properties window delete the Label text
and type ib_1 in the Sprite box. Adjust-

Programming

click on the radio button next to Right
so that all justification is switched off.

| Label properties
Name
Text
Sprite | ib_1| |
Justify ) Left ) Right ) Centre
Details.. |  Cancel || oK |

Click Details and amend Width and
Height to 2600 and 130 respectively.
Then click Close then OK. Now click
and hold the red frame. Drag it up and
left so the edges of the frame disappear
off the edges of the window.

In WinEd's main window save the
templates to a suitable location on your
hard disc and ensure the currently
selected directory is set to where
you’ve saved. I suggest a new folder
called IconBar in the Utilities directory.

We now need to create a sprite called
ib_1. Listing 1 will do the job, it creates

Fia = 3y

16:04:13
12/4/23 240M
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PROCput (8, i%64,927-j%64)
Leaky Roof i

PROCput (2, bx,383)
This game shows what you can do m_ REPEAT d=d+1

thanks to the easy sprite system on kx=RHD(309) #4

RISC OS and a few lines of code. REM From a ZX Spectrum Game "Dpip "y
) Oﬁgfiflaluy g'mm a dspearun{l lilsﬁng, ﬁEgEDigg HFEMP Spring 2023 EEE%;HB(H,B) Drip “;d
one bucket, Use the 7 nd X keys to I ERROR REPORSPRINT at *séiad PR Sot o ochnngesor
left and right, The rain lasts for " PItes -5LPRINT THBCO, BV /SEORE ssc
move lett and right. The rain lasts for sc=B: PRINT "SCORE ":sc -ké'IHKEV$(B) ! / '-(k$'",ﬁcHHD by 1208)
thirty drips and speeds up —so catchas oL 24:H0UE 8,375:PLOT 1,1289,0 HRsng D bl X
many as you can. FOR j=8 T0 1 IF a zPRI]C X hvds .
EOR i=8 T0 19 X put{2,bx,383) :bx+=dx*16:PROCp
SCORE 12 Drip 13 "Dkdel (1+(38-)79
S S S ) S S ) ) ) ) e [T e
ky=ky-8
UNTIL ky=399
UNTIL d=38

END

DEF PROCput (A, X, 1)
§V5 "0S_Spritelp”,4122,5,5TREA, X, Y,3
ENDPROL

DEF PROCdel(T)
T1=TIHE:REPEAT UNTIL TIME)TL+T
ENDPROC

DEF PROCsprites
%=1088:DIH § X,C 3
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Tesellation Ed:tor

Over the years there have been more
sprite editors for the BBC Micro and
Electron than I’ve had hot dinners.

The sprite designer presented here
offers one significant advantage over all
the others I’ve seen and that is the
ability to see the sprite tessellating with
itself as you edit.

It runs equally happily on 8-bit
Acorns and RISC OS machines,
!GraphTask is recommended on the
Raspberry Pi. If you are only going to
be using a BBC Micro (or emulator)
you don’t need to type in lines 300 and
lines 490-640.

When you run the program, input the
graphics mode for the sprite which can
be zero, 1, 2,4 or 5 (plus 8 or 9 on
RISC OS) followed by the sprite
dimensions in pixels.

Move the X cursor round the editing
area with the arrow keys. Keys 0-9 and
A-F will colour in the square on the
grid and it will also plot nine copies of
the pixel at actual size on the right — the
sprite plus its eight neighbours

i

When you have finished designing your
sprite, press the Return key and enter a
filename. On the BBC Micro a series of
DATA statements will be spooled to
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disc and on RISC OS the data will be
saved as a standard sprite file which can
be opened in Paint.

'
H iéli glMPL gPr‘l!E !Mor

20 REM (c) Drag M Drop Spring 2823
30 ON ERROR OSCLI"FX4,8":REPORT:PRINT
" at ";ERL:END
48 REPEAT IHPUT "Mode",modes
30 mode=INSTR("8124589",mode$)-1:UNTI
L node}d
68 INPUT"Hidth, Depth",w,d
78 MODE UALmodes$
88 UDU23;8282;8;8;0;
98 DIM pix(w,d)
180 gx=UALMID%$("2484824" ,mode+1, 1) :REM
graphics points per pixel ¥
118 pe=UALMID%$("8428484" ,mode+1, 1) :REM
pixels per column
128 ce=w DIV pc : cr=1#((d-1) DIV §)
138 xs=B%qgx:ys=32 :REW size of cell gr
aphics units
148 rm=ccepckxs + gxpckcc + gx (REM r
ight margin
150 xc=8: yc=B: a$="8123456789ABCDEF"
160 *F¥4,1
178 PROCcursor
188 REPEAT
198 k=G6ET
288 PROCcursor




Hardware

pin number 1 positioned bottom. Pin 2
1s on the left, pin 3 on the right above
pin 1 and so on all the way up to pin 40.

Pesky here again from the Antipodes,
mates, and pack your swag as we’re
heading to the uncharted territory of
your computer — the GPIO port.

The BBC Basic 5 computer language
available on a RISC OS based
computer can be used to input data via
its GPIO pins.

Using GPIO pins you can collect
data from the outside world as well.
Once you learn how to do that safely,
without harming the Pi, other fun
projects are waiting for you to do.

In recent versions of the Raspberry o , ) ,
Pi the GPIO pins are positioned on the ~ INeXtis a ‘pin map’ table orientated in
left hand side of the circuit board. the same manner. The pins are

Take a squiz at the picture, pins are numbered the same in middle two

organised into a 2 x 20 rectangle with ~ columns.

Pin 40,

The Raspberry Pi GPIO pins

Pin 2

-
&
[
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